About this User’'s Manual

This user’'s manual is designed to let you easily find the information you need
to get the most from your notebook.

e Introduces you to the features of your notebook.

e Gives you useful details on using your notebook.

e Tells you how to look after your notebook, whether at home or traveling.
e Talks about PC Card peripherals and how to use them.

e Goes into more detail about power management and explains how to
conserve power while on the move.

e Introduces you to BIOS, the nervous system of your computer, and how to
change its fundamental settings.

There is no need to read the manual from the beginning to end. Simply find
your way to the section that interests you using the index, or browse through
the manual.

You will come across the following icons in the manual:

@ Helpful pointers and tricks to get more from your notebook

To help you note and avoid possible damage to your notebook's hardware
or software, or loss of your work

n Points out possible damage to property, personal injury or death

Information in this document is subject to change without notice.

© Compal Electronics, Inc. 2006. All rights reserved.

Trademarks used in this document: Microsoft and Windows are registered
trademarks of Microsoft Corporation.

Other trademarks and trade names may be used in this document to refer to
either the entities claiming the marks and names or their products.
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Safety Instructions

Safety Instructions

Use the following safety guidelines to help protect yourself and your computer.

General Warnings

Do not operate your portable computer for an extended period of time with
the base resting directly on your body. With extended operation, heat can
potentially build up in the base. Allowing sustained contact with the skin
could cause discomfort or, eventually, a burn.

Do not attempt to service the computer yourself. Always follow installation
instructions closely.

To avoid personal injury from electric shock or fire:

Completely power down the computer when replacing memory modules,
cleaning the computer, its components, or chassis, or performing
operations requiring similar steps. To do this, first turn the power off at
the power switch, remove the battery, then disconnect the AC adapter
from the electrical outlet or from any other type of external power source,
such as an external battery.

Do not operate the computer near water, for example, near a bathtub,
kitchen sink or laundry tub, in a wet basement, by a swimming pool, or
in the rain.

Do not connect or disconnect any cables or perform maintenance or
reconfiguration of this product during an electrical storm.

Avoid using the wired modem or LAN during an electrical storm, as a
remote risk of electric shock from lightning exists.

Do not push objects into air vents or openings of your computer or
accessories. Doing so can short out interior components and may
cause fire or electric shock.

When installing memory modules, ground yourself by touching a
grounded conductive surface, such as a device with a grounded plug.
Avoid touching the pins and leads on the memory module or internal
circuitry of the computer.

When setting up the computer for work, place it on a level surface.

Handle components with care. Hold a component such as a memory
module by its edges, not its pins.




Safety Instructions

If the battery pack leaks and the fluid get in your eyes, do not rub them.
Instead, rinse your eyes with clean running water and immediately seek
medical attention. Otherwise, eye injury may result.

If acid leaking from the battery pack contacts your skin or clothing,
immediately wash it away with running water. Otherwise, skin inflammation
can occur.

Operate the computer at the recommended temperature range of +5°C to
+35°C (+41°F to +95°F). Store it at a temperature of -20°C to +60°C (+4°F
to +140°F).

Power Cord & Adapter Warnings

Read the installation instructions before connecting to the power supply.

Power cord sets for use in other countries must meet the requirements of
that country. Use the appropriate AC adapter and power cord for your
locale.

If you use an extension cable with your AC adapter, ensure that the total
ampere rating of the products plugged into the extension cable does not
exceed the ampere rating of the extension cable. Also, ensure that the total
rating of all products plugged into the wall outlet does not exceed the fuse
rating.

When using your power cord, make sure to position it around objects so it
will not be cut or punctured.

When you disconnect a cable, pull on its connector on its strain relief loop,
not on the cable itself. As you pull out the connector, keep it evenly aligned
to avoid bending any connector pins. Also, before you connect a cable
make sure both connectors are correctly oriented and aligned.

Be sure that nothing rests on your AC adapter’s power cable and that the
cable is not located where it can be tripped over or stepped on.

Use only the AC adapters that are approved for use with this computer.
Use of another type of adapter may risk fire or explosion.

Before you connect the computer to a power source, ensure that the

voltage rating of the AC adapter matches that of the available power

source.

- 115 V/60 Hz in most of North and South America and some Far Eastern
countries such as South Korea and Taiwan.

- 100 V/50 Hz in eastern Japan and 100 V/60Hz in western Japan.

- 230 V/50 Hz in most of Europe, the Middle East, and the Far East.




Safety Instructions

Place the AC adapter in a ventilated area, such as a desktop or on the floor,
when you use it to run the computer or to charge the battery. Do not cover
the AC adapter with papers or other items that will reduce cooling; also, do
not use the AC adapter while it is inside a carrying case.

To remove power from the computer, turn it off, remove the battery, and
disconnect the AC adapter from the electrical outlet.

Disconnect power cords and cables by grasping the connector, not by
pulling on the cable itself. As you pull out the connector, keep it evenly
aligned to avoid bending any connector pins. Before you connect a cable,
make sure both connectors are correctly aligned.

Battery Pack Warnings

Do not carry a battery in your pocket, purse, or other container where metal
objects (such as car keys) could short-circuit the battery terminals. The
resulting excessive current flow can cause extremely high temperatures and
may result in damage from burns.

Danger of explosion may occur if battery is incorrectly replaced. Replace
only with the same or equivalent type battery recommended by the
manufacturer.

Do not dispose of batteries in a fire. They may explode. Check with local
authorities for disposal instructions.

Do not use or leave the battery pack near a heat source. Heat can melt the
insulation and damage other safety features, possibly leading it to leak acid,
overheat, emit smoke, burst and/or ignite.

Do not immerse the battery pack in water or allow it to get wet. Its protective
features can be damaged. Abnormal chemical reactions may occur, possibly
leading it to leak acid, overheat, emit smoke, burst and/or ignite.

Do not crush, disassemble, puncture, or incinerate short external contacts of
battery pack.

Do not connect the positive (+) and negative (-) terminals with a metal object
such as wire. Short-circuiting may occur, leading the battery pack to leak
acid, overheat, emit smoke, burst and/or ignite.

Do not use an apparently deformed or damaged battery pack, which may
leak acid, overheat, emit smoke, burst and/or ignite.

If the battery pack leaks, gives off a bad odor, generates heat, becomes
discolored or deformed, or in any way appears abnormal during use,
recharging or storage, immediately remove it from the computer or charger
and stop using it.




Safety Instructions

Battery Pack Disposal

- Dispose of the lithium ion battery packs only at approved disposal sites. To
locate an appropriate site, contact the solid waste disposal officials where
you live or look for a rechargeable battery recycling website that lists
disposal locations near you.

- Do not dispose of battery packs in a fire, throw them in a trash receptacle,
put them in a recycling bin not intended for their disposal, or otherwise
discard them in a manner that may result in their being hazardous to the
environment.

Internal Modem Warnings

CAUTION: When using your telephone equipment, basic safety precautions
should always be followed to reduce the risk of fire, electric shock and injury to
persons, including the following:

- The modem cable you connect to your computer should have a minimum
wire size of 26 AWG (American wire gauge) and an UL-compliant RJ-11
modular plug.

- Avoid using a telephone (other than a cordless type) during an electrical
storm. There may be a remote risk of electric shock from lightning.

- Do not use the telephone to report a gas leak in the vicinity of the leak.

- Do not plug a modem connector (RJ-11) into a network connection (RJ-45).
This may damage the connector.




Modem Regulatory Notice

Modem Regulatory Notice

Federal Communication Commission PART 68 Warning

This equipment complies with Part 68 of the FCC rules. Located on the bottom
side of the modem is a label that contains, among other information, the FCC
Registration Number and Ringer Equipment Number (REN) for this equipment.
Upon requested, you must provide this information to your telephone
company.

If your telephone equipment causes harm to the telephone network, the local
telephone company may discontinue your service temporarily. If possible they
will notify you in advance. But, if advance notice is not practical, you will be
notified as soon as possible. You will also be informed of your right to file a
complaint with the FCC.

Your telephone company may make changes in this facilities, equipment,
operations, or procedures that could affect the proper functioning of your
equipment. If they do, you will be notified in advance to give you an opportunity
to maintain uninterrupted telephone service.

If this equipment should fail to operate properly, disconnect the equipment
from the phone line to determine if it is causing the problem. If the problem is
with the equipment, discontinue use and contact your dealer or vendor.

TBR21

This equipment has been approved [Council Decision 98/482/EC — “TBR21"]
for pan-European single terminal connection to the Public Switched Telephone
Network (PSTN). However, due to differences between the individual PSTNs
provided in different countries, the approval does not, of itself, give an
unconditional assurance of successful operation on every PSTN termination
point. In the event of problems, you should contact your equipment supplier in
the first instance.




Modem Regulatory Notice

Important Safety Instructions

Read these instructions carefully. Save these instructions for future reference.

1.
2.

Follow all warnings and instructions marked on the product.

Unplug this product from the wall outlet before cleaning. Do not use liquid

cleaners or aerosol cleaners. Use a damp cloth for cleaning.

Do not place this product on an unstable cart, stand, or table. The product

may fall, causing serious damage to the product.

Slots and openings in the cabinet and the back or bottom are provided for

ventilation; to ensure reliable operation of the product and to protect it

from overheating, these openings must not be blocked or covered. The
openings should never be blocked by placing the product on a bed, sofa,
rug, or other similar surface. This product should never be placed near or
over a radiator or a heat register, or in a built-in installation unless proper
ventilation is provided.

This product should be operated from the type of power indicated on the

marking label. If you are not sure of the type of power available, consult

your dealer or local power company.

Do not allow anything to rest on the power cord. Do not locate this product

where persons will walk on the cord.

Never spill liquid of any kind on the product.

Do not attempt to service this product yourself, as opening or removing

covers may expose you to dangerous voltage points or other risks. Refer

all servicing to qualified service personnel.

Unplug this product from the wall outlet and refer servicing to qualified

service personnel under the following conditions:

a. When the power cord or plug is damaged or frayed.

b. If liquid has been spilled into the product.

c. If the product has been exposed to rain or water.

d. If the product does not operate normally when the operating
instructions are followed. Adjust only those controls that are covered
by the operating instructions since improper adjustment of other
controls may result in damage and will often require extension work by
a qualified technician to restore the product to normal condition.

e. If the product has been dropped or the cabinet has been damaged.

f.  If the product exhibits a distinct change in performance, indicating a
need for service.

Vi



Modem Regulatory Notice

EMC Regulatory Information

This product is designed and tested to comply with the following related EMC
(Electromagnetic compatibility) standards.

FCC Notice

“Declaration of Conformity Information”

This equipment has been tested and found to comply with the limits for a Class
B digital device, pursuant to Part 15 of the FCC Rules. These limits are
designed to provide reasonable protection against harmful interference in a
residential installation.

This equipment generates, uses and can radiate radio frequency energy and, if
not installed and used in accordance with the instructions, may cause harmful
interference to radio communications. However, there is no guarantee that
interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be
determined by turning the equipment off and on, the user is encouraged to try
to correct the interference by one of following measures:

e Reorient or relocate the receiving antenna.

e Increase the separation between the equipment and receiver.

e Connect the equipment into an outlet on a circuit different from that to
which the receiver is connected.

e Consult the dealer or an experienced radio/TV technician for help.

This device complies with Part 15 of the FCC Rules. Operation is subject to the
following two conditions:

(1) This device may not cause harmful interference.
(2) This device must accept any interference received, including interference
that may cause undesired operation.

Vii



Modem Regulatory Notice

Canadian Notice (Canada Only)

This digital apparatus does not exceed the Class B limits for radio noise emis-
sions from digital apparatus as set out in the Radio Interference Regulation of the
Canadian Department of Communications.

This Class B digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe B est conformé a la norme NMB-003
du Canada.

CE Notice (European Union)

EU Declaration of Conformity

The product conforms to the following standards:

Supplementary Information: “The product complies with the requirements
of the Low Voltage Directive 73/23/EEC and
the EMC Directive 89/336/EEC and/or the
R&TTE Directive 1999/05/EEC.”

This product is carrying the CE-Mark in accordance with the related European

Directives.

BSMI Notice (Taiwan Only)

Most Compal computer products are classified by the Bureau of Standards,
Meteorology and Inspection (BSMI) as Class B information technology
equipment (ITE).

-@ The symbol that must be marked on the product indicates the product
complies with BSMI standard.

R 31138

viii
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Macrovision License of Notice

This product incorporates copyright protection technology that is protected by
methods and claims of certain U.S. patents and other intellectual rights owned
by Macrovision Corporation, and other rights owners. Use of this copyright
protection technology must be authorized by Macrovision Corporation and is
intended for home and other limited viewing uses only unless authorized by
Macrovision Corporation. Reverse engineering of disassembly is prohibited.
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Specifications

CPU
o Intel Yonah Processors FSB 667 MHz / 2MB L2
. Dual Core / Single Core
. Up to Intel’s roadmap
Chipset
. Intel Calistoga-PM (945PM) for discrete video
. ICH7-M

J 533/667MHz FSB support

Memory
o Supports DDR-I1 533/667MHz
. No on-board memory

. Two SO-DIMM with 512MB/1GB modules
. Upgradable to 2GB memory by two SO-DIMM

. Easy install from bottom side

VGA Board
. Nvidia G73M
o 256MB memory
Display
o Supports 14.1” WXGA TFT color LCD
Keyboard
) 86/87/90 keys support with 101/102 key emulation without stick-point
. 2.5+0-0.3mm stroke 5.1+0.3mm total height
. Supports Windows key and Application keys

o Multi-language support
HDD

. 9.5mm height, 2.5” HDD

. Easily removable

° PCI Bus Master Enhanced IDE
. Supports SATA 1.5Gb/s (150MB/s)




Specifications

Select Bay Devices
o 5.25” 12.7mm height 24X DVD/CD-RW Combo
. 5.25” 12.7mm height 8X DVD-Super Multi devices

Options
. 512MB/1GB SO-DIMM DDR-II
. Li-lon Battery pack
. PCI-E Wireless module
. Bluetooth Ver. 2.0 module with USB2.0 interface

Pointing Device
. Touch Pad with two buttons
- Left button
- Right button
. Finger printer
I/O Ports
. USB 2.0 ports x 3
o VGA port, 15 pins x 1
J S-Video out port x 1
J Microphone-in x 1
J Headphone-out jack x 1
. DC-in jack x 1
) RJ-11 jack for 56Kbps V.92 Modem (US/Canada/UK/Germany/French)
) RJ-45 jack x 1
. Kensington lock x 1
. ExpressCard/54 x 1
. PCMCIA slot x 1
. 3-in-1 card reader for SD/MMC/MS

) Built-in microphone

PCMCIA Card Organization
. ENE CB714 (included Card bus + Flashcard Reader controller)
. PC Card 95 supported with one type-I1 (No type-I11 support) card sockets
o No ZV-Port support
. Power switch ENE CP2211

Xi



Specifications

Excellent Power Management Function

Standby mode, Suspend to RAM or Suspend to Disk mode, by time out
or by hot key

HDD Local Stand-By mode by time out
LCD Local Stand-By mode by time out
Low battery alarm by beep

Auto-backlight off when LCD cover closed
Full ACPI 2.0 support

LCD Auto-DIM mode by time out

AC Adapter

Universal AC adapter. 90-264V AC, 47-63Hz
90W with 19V DC output
3 pin type for AC inlet

Xii
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1 Introducing Your Notebook

1.1 Front Side

The following picture shows the front side of the HGL30 notebook.

B WN =

L ~ OO O,

13 14 15
1 | LCD Module Latch 9 | Keyboard
2 || Built-in Camera 10 || Touch Pad
3 || Built-in Microphone 11 || Touch Pad Buttons Keyboard
4 || Display 12 || Device Status Indicators
/ Power Status
5 | Power Button 13 | Multiple Digital Media Slot
6 || Keyboard Status Lights 14 | Wireless Communication Switch
7 || Easy Buttons 15 || Finger Printer
8 || Media Office Buttons
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1 Introducing Your Notebook

1.1.1 LCD Module Latch
The LCD Module Latch secures the display case to your notebook. To open the display,
slide the latch to the right and lift the display. When you close the display, the latch secures
it automatically.

1.1.2 Built-in Camera
The built-in camera features a 1.3mega pixel CMOS web camera.

1.1.3 Display
Your display is a 14.1” COLOR TFT/WXGA.

1.1.4 Power Button

Press the button to turn your notebook on. For more on power settings, see 5.1 Power
Management.

L wedinOfice — |

Windows XP, which comes preinstalled, goes into the shutdown sequence
automatically if you press the power button while on.

You can configure this in Control Panel: Power Options — Advanced.

1.1.5 Easy Buttons

These buttons launch your favorite programs.

=) Internet access button

(| Email button

|_ Medin Office —— |
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1 Introducing Your Notebook

1.1.6 Media Office Buttons

Media Office provides Audio / Video recording function to utilize the advantages of array
microphone and built-in camera. By operating Media Office buttons, you can enjoy all
functions of this application.

MODE REC I4d Ip/m  »»l

MODE
= o1 Fe

|_ Madia Office _l

There are 4 modes in Media Office.

= Solo: Recording audio in front of the notebook.
= Conference: Recording audio all around the notebook.
= Video: Recording video and audio in front of the notebook.

= Photo: Pictures capturing.

The following table describes all functions and related button definition:

Mode Solo Conference Video Photo
Button
Short Launchs Media Office. With the press of this button when Media Office is
Press launched, the mode changes in the following order: Solo - Conf - Video
Mode - Photo 2 Solo.
Long . Closes Media Office.
Press
Short
Press Recording Recording Recording . .
REC Long audio audio video + audio Taking pictures
Press*
ghort Returns to previous media file.
|4« ress
Long Decreases the volume
Press* '
Short Plays selected media file.
Press
I»/m
Long Stops playing / recording
Press* '
Short Jumps to next media file.
() Press
Lon
g
Press* Increases the volume.

*Long Press: Press the button over two seconds.
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1 Introducing Your Notebook

1.1.7 Keyboard

The keyboard includes a numeric keypad and the Microsoft® Windows® logo key.

See 2.3 Keyboard and Touch Pad for details on using keyboard shortcuts.

1.1.8 Keyboard Status Lights

Y

a2

@ | Indicates uppercase letter function enabled.
@ | Indicates numeric keypad enabled.
@ | Indicates scroll lock function enabled.

AN

1.1.9 Touch Pad

MODE

a1 PP

I— Madia Office ____-.l

The touch pad works as a desktop mouse. For more information, see 2.3 Keyboard and
Touch Pad.
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1.1.10 Touch Pad Buttons

The left and right touch pad buttons work as the left/right buttons on a standard mouse.

1.1.11 Finger Printer

The finger printer allows you to enroll the computer with registered fingerprint. This
recognition device helps prevent unauthorized access by others. For more information, see
2.3.7 Finger Printer.




1 Introducing Your Notebook

1.1.12 Multiple Digital Media Card Slot

Supports one SD/MMC/MS card, which is used in digital still camera and various forms of
portable information equipment.

1.1.13 Wireless Communication Switch

Turns the wireless communication function on or off. The wireless communication LED ‘P
on the front panel lights when the function is activated.

1.1.14 Device Status Indicators / Power Status

The LEDs on the front side of notebook indicate the device and power status.

12345

1 || Power On (Green)

2 || Battery Charge (Green/Amber)

3 | HDD (Green)

4 || For SD/MS/MMC Card (Green)

5 || Wireless (Blue)

The flashing Power On LED indicates the notebook is in standby mode.
For detailed battery status, see 5.2 Battery.
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1 Introducing Your Notebook

1.2 Right Side

The following picture shows the right side of the HGL30 notebook.

1 || Audio Ports

2 USB Ports

3 || Optical Media Drive

4 VGA Port
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1 Introducing Your Notebook

1.2.1 Audio Ports

You can connect a headphone or an external speaker to the P port and a microphone to the
N
’ port. The built-in speakers are disabled when a device is connected to the Q) port.

1.2.2 USB Ports

Use this port to connect a USB device, such as a mouse, full-size external
‘ :_- keyboard, or printer, to the computer.

'@‘ USB is a peripheral expansion standard that supports a data-transfer rate up to 480
Mbps. USB peripherals have a single standard for cables and connectors. You can
install and remove USB devices while the computer is on. This is known as "hot
swapping".

1.2.3 Optical Media Drive

The optical media drive provides a means for you to import/export data and small files

into/from your computer. Depending on the configuration of your computer, you may either
be able to record CDs or play DVDs.

1.2.4 VGA Port

Use this port to connect an external monitor to your computer. See 1.1.3

- Display.
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1 Introducing Your Notebook

1.3 Left Side

The following picture shows the left side of the HGL30 notebook.

1 K-Lock
2 USB Port
3 LAN Jack

4 || PC Card Slot

5 || Express Card Slot
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1 Introducing Your Notebook

1.3.1 USB Port

Use this port to connect a USB device, such as a mouse, full-size external
¢ _\L- keyboard, or printer, to the computer.

'Q‘ USB is a peripheral expansion standard that supports a data-transfer rate up to 480
Mbps. USB peripherals have a single standard for cables and connectors. You can
install and remove USB devices while the computer is on. This is known as "hot
swapping".

1.3.2 LAN Jack

The RJ-45 network jack allows you to connect your notebook to a local area
W B network (LAN).

& Be careful not to plug the telephone line into the slightly larger network connector.

1.3.3 PC Card Slot

Supports one Type Il PC card. For more information, see 4.1 PC Cards and Express Cards.

1.3.4 Express Card Slot

Supports one 54mm type PCI Express card. For more information, see 4.1 PC Cards and
Express Cards.
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1.4 Back Side

The following picture shows the back side of the HGL30 notebook.

1 || S-Video out Port

2 Modem Jack

3 | AC Adapter Connector
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1 Introducing Your Notebook

1.4.1 S-Video out Port

The S-Video out port allows you to connect an external display device, like TV
@ set or device which has S-video port, to the notebook.

1.4.2 Modem Jack

The modem jack allows you to connect the notebook to a telephone line with a
standard RJ-11 connector.

1.4.3 AC Adapter Connector

- 1N AC adapter connector allows you to connect an AC adapter when your
mmmmE=  notebook is switched on or off.

n While the AC adapter works with electrical outlets worldwide, power connectors
and power strips vary from country to country. Ensure you use compatible cable
and correctly connect the cable to the power strip or electrical outlet. Failure to do
S0 may cause fire or damage to equipment.
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1 Introducing Your Notebook

1.5 Bottom Side

The following picture shows the bottom side of the HGL30 notebook.

1
2

Battery Pack

Battery Release Latch

Memory Module Cover

HDD Cover

Battery Lock Switch

Thermal Cover
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1.5.1 Battery Pack

With a charged battery pack installed, you can use your notebook without connecting it to
an electrical outlet. For more details, see 5.2 Battery.

To remove the Battery Pack:

1. Move the Battery Lock Switch to the right (Unlock position).

2. Slide the Battery Release Latch to the left and gently pry the Battery Pack from the
computer chassis.

1.5.2 Battery Release Latch

The Battery Release Latch secures the battery pack. To release, slide the latch and then
remove the battery pack from the bay.
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2  Operating Your Notebook

2.1 Turning Your Notebook On and Off

vV V VvV VYV VY

Turning Your Notebook On
Turning Your Notebook Off
Logging Off

Adding User Accounts

Standby Mode
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2.1.1 Turning Your Notebook On

'QI You can configure the computer to start from a specific drive, such as a CD-ROM,
an external floppy disk, or even an external device. See Chapter 6 The BIOS Setup
Program.

Press the power button to turn on your notebook.

Do not turn off the computer until the operating system has loaded completely.
Turning the computer off during its initial startup will result in an error the next
time you start your notebook.

2.1.2 Turning Your Notebook Off

'Q‘ If your notebook is using Microsoft Windows XP Professional operating system, the
security and networking features are not available in Windows XP Home Edition.
You will see different options in some windows, related to security and networking.

Save and close any open files, exit any open programs.
Click Start > Turn Off Computer > Turn Off.
Your notebook will automatically turn off after the shutdown process is finished.

You can configure Windows XP to shut down or go into sleep mode by pressing the
power button. Open the Control Panel: Power Options — Advanced dialog box to
do this.

2.1.3 Logging Off

With Microsoft Windows XP, multiple users can access a single computer with their own,
personal settings. Using their own password, each user logs on to the computer, meaning
other users cannot access their settings or files. To log off:

Save and close any open files, exit any open programs, click Start > Log Off > Log Off.
To switch users, click Start > Log Off > Switch User.

Using Fast User Switching, programs that previous users were running remain running in
the background. This means a possible slower computer response. It may also stop
multimedia programs, including games and DVD software, from running.

’Q‘ Fast User Switching does not work if your notebook is running Windows XP
Professional and is a member of a computer domain or if the notebook has less than
128 MB of memory.

You can set up Fast User Switching in the Control Panel dialog box, under User
Accounts: Change the way users log on or off.
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2.1.4 Adding User Accounts

'Q] Different account options are available when a computer is running the Windows
XP Professional operating system and is connected to a domain.

With Windows XP installed, the system administrator or a user with administrator rights can
create additional user accounts:

1. Click Start > Control Panel > User Accounts.

2. Under Pick a task, click Create a new account.

3. Under Name the new account, enter the name of the new user. Click Next.
4. Under Pick an account type, choose one of the following options:

e Computer administrator: User can change all computer settings.

e Standard (Windows XP Professional only): User can install some programs
and hardware.

e Limited: User can only change his own personal settings, such as the password.
User is not able to install programs or use the Internet.

5. Click Create Account.
2.1.5 Standby Mode

To find out how to conserve power using the Standby Mode, see 5.1 Power Management.
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2.2 Tips for Using Windows

Microsoft Windows XP Help
Windows Desktop

Start Button

Taskbar

Notification Area (System Tray)
Recycle Bin

Control Panel

YV VvV VvV ¥V VY V VYV VY

My Computer
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2.2.1 Microsoft Windows XP Help

Pick a Help topic

{2 Help and Support Cemler

For Microsoft Windows XP help, click the Start menu then click the Help and Support
icon. The Help and Support Center dialog box opens.
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Wiraliaay [ n
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Weskibreg Feimolbely
Seourfy aned adeinintration

CLAAETHIN Yol ChniHaler
A oessibalily

Prinl ey ssrvil i
Perfarmange sl momtenanon
Hasialeire

Fiestray @ prohleny

Send yier [endhock be Microsoll

(&) Help and Support Center

Ask for assistance

[3] a4 v 11 emrwimct by Yo crigniis weth Rermte Aesiatante

I'_}. it sagiport, or b ebormastion| 0 Windosss X1 nessgroups

Pick a task
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2  Operating Your Notebook

2.2.2 Windows Desktop

f@] Depending on your notebook setup and software, your desktop may have different or
additional shortcuts. See 2.4 Personalizing Your Desktop for more information.

Recycle
Bin

:
'y

Windows

Professional

Start button Taskbar Notification Area
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2.2.3 Desktop Cleanup Wizard

The Desktop Cleanup Wizard moves icons for programs not frequently used to a folder 7
days after you first start your notebook and every 60 days after that.

The Start menu's appearance changes as program icons are moved. To turn off the Desktop
Cleanup Wizard:

Right-click an empty spot on your desktop > Properties > Desktop > Customize Desktop
> click Run Desktop Cleanup Wizard every 60 days to remove the check mark > OK.

The Desktop Cleanup Wizard can be run any time by clicking Clean Desktop Now under
Desktop cleanup.

2.2.4 Start Button

The Start button allows easy access to your notebook's programs.

acy13Test

é IIrrlEmf;-l. __J,:r My Documents
.,:;'j Ié-rmﬂ . ___:j My Recent Docu,., *
S ) My Pictures
AcrobatReader 4.0 | [y My Music
ﬁ HyperSnap-DX 35 My Computer
— \5} My Metwork Places
[!; Motepad
' [3- contrci panel
C,Hﬂb; Ly Printers and Faxes
_,: Regster
:" Hypersnap-Dx ) Help and SLppart
? WiordPad ,»-) Search
1 R,
All Programs b @ SoUbon Cenber

m Log off [ Tum off Computer

The Start menu is designed to show the programs you use most frequently. To always keep
an item on the Start menu, no matter how often it's used, right-click the item and click Pin
to Start menu.

Log Off allows the current user to log off so a new user can log on to the notebook using his
personal settings.

Turn Off Computer provides options for turning off, restarting, and placing your notebook
in power saving modes. If your notebook is running Windows XP Professional and is
connected to a domain, different options appear in the Shut Down window.
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2.2.5 Taskbar

The Start button is on the left and the notification area on the right. Each time you open a
program, a button for it appears on the taskbar. To toggle taskbar buttons, click the relevant
button. Windows XP groups multiple instances of the same program on a single taskbar
button if more space is needed.

Toolbars can be added to or removed from the taskbar:

Right-click an empty spot on the taskbar, and select Toolbars > choose the toolbar you
want to add.

2.2.6 Notification Area (System Tray)

The icons in this area allow quick access to programs and computer functions, including the

clock and printer status. Windows XP hides icons that are not used frequently. Click ¥ to
see hidden icons.

To prevent Windows XP from hiding icons:

Right-click an empty spot on the Taskbar > Properties > ensure that Hide inactive icons is
not checked.

Taskbar and Start Menu Properties ﬁ’TiE!

Taskbar | Shart Menu

Tanhbe appearance

T Z Internat..r | B Folder

[¥] Lock the taskbar

] Auftohicha the baskbar

[#] Kemp the taskbar on top of cthes windows
[¥] Groap simia tackbag battons

1 Shwowe Qusick Launch

hooblicaton aea

kg 1533 PM

[] 5 browe thes choek:

o can keep the nodhcation arsa unchtbensd by hiding icons that you
hawe not chcked racently

s i

[ ok J[ comce J[ eoow ]

s |
2.2.7 Recycle Bin —-FJ

When you delete a file, it is moved to the Recycle Bin. Files can be restored from the
Recycle Bin.

Emptying the Recycle Bin deletes files permanently.
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2.2.8 Control Panel

In the Control Panel, you can change how Windows looks and works.
Click the Start button and then Control Panel.

There are two interfaces - you can choose either Classic View or Category View. You can
switch interfaces in the upper left hand window of the Control Panel dialog box.

Under Pick a Category, choose the category of the task you wish to complete, and then
choose the task in the next window.

B Control Panel

E' Cortrol Paned = Pick g EﬂtEgﬂr}'

Appearance and Printers and

Thietnees . Ot heer Hardwrare
o T

Spbwprerd pied
T ermeet

L
-
[ oanane-Chiies e

- LHeer Acconmnl s
¥

L] Ty
Fuidd o Remove Dale, i

Prongr arms i ::_-:rrﬂm nrﬁ-:ﬂ i

Soamils, Sperich,
st Auiio Accessity
Devices Optinns

Pedormance and

2.2.9 My Computer

My Computer allows you to see the contents of your notebook's drives. The My
Computer icon appears on your Desktop. To see the contents of a drive or folder, open My
Computer then double-click the icon for the drive or folder you want to view (for example,
drive C).

You can also use Windows Explorer to see the contents of your notebook and find
files. To open Windows Explorer, right-click the Start button and click Explore to
find the drive or folder that you want to view. To find out more about My Computer
and Windows Explorer, see Help and Support Center.
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2.3 Keyboard and Touch Pad

Numeric Keypad

Keyboard Shortcuts

Windows Logo Key Functions
StickyKeys

Touch Pad

Customizing the Touch Pad

vV VvV VvV VY VYV V VY

Finger Printer
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2.3.1 Numeric Keypad

Keypad numbers and symbols are marked in blue on the lower right edge of the keypad
keys.

To enable the numeric keypad, press !E!

The ﬁ indicator will light when the numeric lock is on.

To disable the numeric keypad, press again.
To use the primary function of a dual-function key when the numeric keypad is enabled,

press B and the desired key.

2.3.2 Keyboard Shortcuts

Sleep

n
3
—
ey
I3
C—

-

3
—
‘E—v

Wireless or Bluetooth

= ~ Switches Display Mode (LCD >CRT >TV > LCD + CRT
Simultaneous > LCD+TV Simultaneous). Switches the video image
to the next display or both displays simultaneously.

Number Lock

.“
3
—
a
L
a
C—)

Scroll Lock

Scrlk

o
3
e
=
5
=
Cr—)

Brightness Down

Brightness Up

D\
m
=2
E E
) C—J Cr—)

.“
E)
a
5
o

Mute

Audio Volume Down

]
3
3
A
-
C—)
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Fn ®al | Audio Volume Up
C—

Fn “wm| | Media Play/Pause
——0

Media Stop

Media Play Backward

Fn

D\
m
=2

Media Play Forward

2.3.3 Windows Logo Key Functions

F T E
;r' Opens Windows Explorer
b
£ . SA R -
gy Opens the Run dialog box
9
£ . NEF -
Ay Opens the Search Results dialog box
3
[ ;:1_3 ymﬂ I Opens the Search Results - Computers dialog box (when
. N J your notebook is connected to a network)

|
g

|

Opens the System Properties dialog box

2

To adjust keyboard operation, including character repeat rate, in the Control Panel click
Printers and Other Hardware > Keyboard.
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2.3.4 StickyKeys

The StickyKeys function lets you use the SHIFT, CTRL, ALT, FN keys or the Windows
logo key (referred to as modifier keys) in conjunction with other keys by pressing one key at

a time instead of simultaneously.

To activate StickyKeys mode, press the Shift key five times and then click OK.

Alternatively, you can click on Start > Control Panel > Accessibility Options and check

StickyKeys

Prezzing the SHIFT key 5 tmes turns on Shckykeys, Shokykeps letz pou yze
the SHIFT, CTRL, ALT, or %Windows Logo keys by prezsing one key at a time.

To keep Stickyleys on, click OF.
T cancel Stickpkeps, click Cancel.
T o deactivate the key combination for Stickyteps, click Settings,

.................................

QF, Cancel Settings

.................................

Use StickyKeys before clicking OK.

Accessibility Options

Keyboard | Sound | Display | Mouse | Gereral|

| Shickykeys

| ze Stickykeys if you want to uge SHIFT, CTRL, ALT, or
Windows logo key by preszing ane key at a time.

. Usze Stickpkeys Settings

Filterk.enz

ze Filkert.evz if vou want Windows toignore brief or repeated
keystrokes, or slow the repeat rate.

[] Usze Filterk eys

Tooglek evz

ze Togglek.eps if vou want to hear tones when prezzing
CAPS LOCK, MUM LOCK, and SCROLL LOCE,

[ ] Uze Togglekeys Settings

[] Show extra keyboard help in programs

ak. ][ Cancel J
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To further customize StickyKeys, click Settings in either of the above dialogue boxes. The
following dialogue box will appear.

Settings for StickyKeys

F.epboard zhortcut

The zhartcut for Stickykeys iz
Frezz the SHIFT key five times.

O ptionz
Preszz modifier key twice to lock
Tumn Stickyteys off i bwo keps are prezzed at once

M otification
take goundz when modifier key iz prezsed
Show Stickpkeys statuz on zcreen

[ OF. ] l Carcel

Click Use shortcut to enable the listed shortcut to activate StickyKeys mode.

By checking Press modifier key twice to lock, pressing the SHIFT, CTRL, ALT, FN or
the Windows logo key twice will 'lock’ the key until it is pressed again. This allows you to
perform multiple commands with these keys in succession without having to press the
modifier key again each time.

Check Turn StickyKeys off if two keys are pressed at once to have StickyKeys
automatically disable whenever any two keys are pressed simultaneously.

If Make sounds when modifier key is pressed is checked, a tone will be heard each time a
modifier key is pressed. Different tones are heard when activating and deactivating modifier
keys.

Check Show StickyKeys status on screen to display the StickyKeys icon in your toolbar
whenever the StickyKeys mode is activated. The icon will change to indicate which
modifier key, if any, is currently active.

Click on OK to confirm your changes, or Cancel to exit the dialogue box without making
any changes.
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2.3.5 Touch Pad

The Touch Pad responds to the movements and pressure of your finger, allowing you to
move the cursor around the screen, in the same way you would with a mouse.

Place your fingers on the keyboard in the normal typing position.

You can use the Touch Pad by moving either your right or left thumb off the space bar and
on to the Touch Pad.

Gently move your thumb across the Touch Pad in the direction you want the cursor to move.

The Touch Pad buttons have the same function as mouse buttons. Clicking these buttons
makes selections, drags objects, or performs a variety of other functions depending on the
software. To select an object, first move the pointer over the object you want to select, and
then press the left button one time and release it. The functionality of these buttons depends
on your software.

Double-clicking is a common technique for selecting objects or launching programs.

You may also select object or execute applications from icons by double tapping. This is
similar to double-clicking; instead of pressing the Touch Pad buttons, you tap the Touch Pad
itself.

2.3.6 Customizing the Touch Pad

To adjust Touch Pad settings, use the Mouse Properties window, which you can open by
clicking Control Panel > Printers and Other Hardware > Mouse.

Select the desired settings and click Apply.
Click OK to save the settings and close the window.
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2.3.7 Finger Printer

The finger printer lets you log on to your computer instead of inputting passwords from the
keyboard.

To raise the recognition success rate, the following illustrations show the correct way to
swipe your finger over the finger printer.

Finger Printer

Align your fingertip with the finger printer as shown in the drawing and swipe.

To reduce the damage to the finger printer and fingerprint recognition problems, follow
these guidelines when using the finger printer.

e Do not scratch or poke the finger printer with your nails or any hard or sharp
objects.

e Do not press the finger printer strongly.

e Do not touch the finger printer with a wet finger or any wet objects. Keep finger
printer surface dry and free of water vapor.

e Do not touch the finger printer with a soiled finger. Minute foreign particles on a
soiled or dirty finger may scratch the finger printer.

e Do not paste stickers or write on the finger printer.

e Do not touch the sensor with a finger or any object with built-up static
electricity.
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2.3.7.1 Delete the Finger Printer Data

Saved fingerprint data is stored in the non-volatile memory inside the finger printer.
Fingerprint data are recommended to delete before you hand over the computer the others,
or dispose of it.

To delete the fingerprint data, do the following:

1.

2
3
4.
5. The Fingerprint Storage Inspector screen is displayed. If other fingerprint data is still

Click Start > All Programs > Protector Suite QL > Control.

. The Protector Suite Software screen is displayed.

Click Fingerprints > Delete.
Click Settings > Fingerprint Storage Inspector.

displayed on the list. Select all fingerprint data and click remove.

Check whether all fingerprint data was deleted on the Fingerprint Storage Inspector
screen.
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2.4 Personalizing Your Desktop

YV V V V

Choosing a Wallpaper
Choosing a Screen Saver
Choosing a Desktop Theme

Creating a Shortcut on the Desktop
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2.4.1 Choosing a Wallpaper

To make your notebook reflect your style, you can set background colors and patterns, and
the wallpaper, on the desktop.

Control Panel > Appearance and Themes > Pick a task > Change the desktop
background.

The Display Properties window offers a choice of wallpapers. Choose the name of the
wallpaper you want to display, or click None if you prefer not to use a wallpaper image.

You can also choose your own images by choosing Browse, and specifying images in a
directory.

The Position pull-down menu lets you either Tile your selected image, Center (places one
copy of the image in the center of the screen) or Stretch (enlarges it to fit the screen).

To accept the settings, click OK and close the Display Properties window.

2.4.2 Choosing a Screen Saver

Control Panel > Appearance and Themes > Pick a task > Choose a screen saver.

Select a screen saver from the Screen saver pull-down menu, or click None if you prefer not
to activate a screen saver.

You can customize your screen saver by choosing Settings. To check your selections, click
Preview.

To accept the settings, click OK and close the Display Properties window.

2.4.3 Choosing a Desktop Theme

Desktop themes change the appearance of your desktop and add sound effects:

Control Panel > Appearance and Themes > Pick a task > Change the computer’s
theme.

Select a theme from the Theme pull-down menu in the Display Properties Window, and
then click OK.

2.4.4 Creating a Shortcut on the Desktop

A shortcut is an icon that is placed on the desktop let you quickly access programs, files,
folders, and drivers. To create a shortcut:

Open My Computer or Windows Explorer, and highlight the file or program you want to
create a shortcut to.

Click and hold down the right Touch Pad button, drag the highlighted item to the Windows
desktop, and then release the right Touch Pad button to display a pop-up menu.

Click Create Shortcut(s) Here.
An icon appears on your desktop - double-click to activate the shortcut.
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2.5 Display

> Adjusting Brightness
> Using an External Monitor or Television

> Setting Display Resolution
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2.5.1 Adjusting Brightness

To conserve power when running your notebook from the battery, set the brightness to the
lowest comfortable setting using the keyboard shortcuts.

=

Fn

C—)

Brightness Down

(7

ry

Fn

G

C—J

Brightness Up

7

2.5.2 Using an External Monitor or Television

When you start your notebook with an external display device such as an external monitor
or television attached and turned on, the image may appear on either the display or the
external device.

Alternatively, you can press @ to switch the video image to the display only, the
display and the external device simultaneously, or the external device only.

2.5.3 Setting Display Resolution

To view a program at a specific resolution, both the video controller and the display must
support the program and the necessary video drivers must be installed.

Before changing any of the original display settings, make a note of the original settings for
future reference.

Start > Control Panel > Pick a category > Appearance and Themes.

Under Pick a task..., click the area you want to change, or under or pick a Control Panel
icon, click Display.

You can try different settings for Color quality and Screen resolution.

If you choose a resolution or color palette that is higher than the display supports, the
settings will automatically adjust to the closest possible setting.
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2.6 Networks

To access a network:
At the office, you can access a network via the built-in PCI-E LAN.

For specific information about connecting to the LAN or WAN, consult your systems
administrator.

If you are working at home or while traveling, you need a dial-up connection. Ask your
system administrator for the telephone number of the network.

To set up the connection, go to Start > Control Panel > Network and Internet
Connections (in Classic Interface, Network Connections).

Enter the details for your connection and click OK.
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2.7 Managing Programs

> Running Programs
> Adding Software

> Removing Software
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2.7.1 Running Programs

Programs are any software that process data - like a word processing program or an email
program. They require an operating system - like Windows XP - to run on.

To run a program, click Start > Programs.
Click the program you want to run.
On the right side of the title bar in the window of any open program,

there are three icons: Elm

E minimizes the program. That is, it is removed from the screen, but is still running. It
will appear as a button on your bottom taskbar. To restore the program, simply click the
button.

E‘ maximizes the window to fill your entire screen. When the window is maximized, the
button switches to which will reduce the size of the window when clicked.

ﬂ closes the program or document.

2.7.2 Adding Software

To check what software is already installed on your computer, click Start > All Programs.
If a program is listed in the All Programs menu or the Start menu, the software is already
installed.

Before installing software, check the software's technical requirements to ensure that it is
compatible with your notebook and that there is enough memory and hard drive space for
installation and operation.

Temporarily disable your notebook’s antivirus software before installing software. See the
documentation that came with the antivirus software for detailed procedure.

r@‘ Be sure to enable your antivirus software once you have installed any new software.
[

Insert the software installation CD into the CD drive and follow the instructions that came
with the software to help you respond to the prompts on the screen.

If the software installation CD does not automatically run, click Start > Run. In the
dialogue box, type x:\setup.exe (where x is the letter of your CD drive [usually D or E]).
Then click OK and follow the prompts on your screen.
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2.7.3 Removing Software

'Q] Once you've begun removing software, do not interrupt the process. To do so may
result in data loss and corruption of your operating system.

Start > Control Panel > Add or Remove Programs > Change or Remove Programs.

Select the program that you want to remove and click the Change/Remove button.
Instructions for removing programs will appear on the screen.

’Q‘ Some programs may not be listed and cannot be removed via this window. In this
case, check the documentation that came with the specific program.

2-27



2  Operating Your Notebook

2-28



2  Operating Your Notebook

2.8 Managing Files
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Updating Antivirus Software
Backing Up Files

Finding Files

Copying a File on the Hard Drive
Copying a File to a Floppy Disk
Moving Files

Renaming Files

Deleting Files

Emptying the Recycle Bin

Retrieving Files From the Recycle Bin
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2.8.1 Updating Antivirus Software

There are thousands of known viruses, and more appear all the time. Installing antivirus
software is the only way to protect your data, software, and hardware. Regular updates are
necessary to ensure protection.

Your computer dealer can advise you regarding purchasing antivirus software.

Before installing any software from unlicensed sources, scan for viruses. Regularly
backup your data to safeguard against loss if your notebook is infected.

2.8.2 Backing Up Files

Regularly backing up your files will protect you from losing data from accidental file
deletion, viruses or hard drive failure.

Programs can be reinstalled, unless you have backed up your work, you will lose your data
files.

The most convenient way to back up your files is to a CD-RW drive. For smaller files, you
can use a floppy disk.

2.8.3 Finding Files

Right click on Start > Search.

In the search window, type either All or part of the file name or A word or phrase in the
file.

Specify where you want the system to look by specifying a drive or folder in the Look in
pull-down menu.

'Q‘ Windows will search the entire hard drive (or drive C partition) if the default setting
of C: is unchanged.

Click Search to begin searching.
Files found that match your search criteria are listed in the Search Results window.

2.8.4 Copying a File on the Hard Drive

From the Desktop, select My Computer.

Locate the file you want to copy, and click the file to select it.

Under File and Folder Tasks > Copy this file.

In the Copy Items window, select the location where you want to copy the file.
Click Copy.
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2.8.5 Copying a File to a Floppy Disk

Insert a floppy disk into the external floppy drive.

From the Desktop, select My Computer.

Locate the file you want to copy, and click the file to select it.

Under File and Folder Tasks > Copy this file > Copy Items > 3% Floppy (A:).
Click Copy.

2.8.6 Moving Files

Never move files that are part of an installed program. Doing so may make the
program unusable.

From the Desktop, select My Computer.

Locate the file you want to move, and click the file to select it.

Click Move this file.

In the Move Items window, click the location where you want to move the file.
Click Move.

2.8.7 Renaming Files

Use Windows Explorer or My Computer to locate the file you want to rename, and click
the file to select it.

Click the File menu and click Rename.

Never change a file's extension (the last three characters after the period). Doing so
may render the file unusable.

Type the new filename and press Enter.
2.8.8 Deleting Files

Never delete files that are part of an installed program. Doing so may render the file
unusable.

Use Windows Explorer or My Computer to locate the file you want to delete, and click
the file to select it.

Click the File menu and click Delete.
Click Yes to send the file to the Recycle Bin.
If you accidentally delete a file, see 2.8.10 Retrieving Files From the Recycle Bin.

2-31



2

Operating Your Notebook

2.8.9 Emptying the Recycle Bin

Files remain in the Recycle Bin and take up space on the hard drive until you empty them
from the Recycle Bin.

Files deleted from a floppy disk or from a network are permanently erased. You
cannot recover them from the Recycle Bin.

Double-click the Recycle Bin icon.

The Recycle Bin window appears and lists all deleted files, their previous locations, and the
dates you deleted them.

Click the File menu, and click Empty Recycle Bin.
When the confirmation dialog box appears, click Yes to delete all file(s).
All files disappear from the Recycle Bin and are removed from your notebook.

2.8.10 Retrieving Files From the Recycle Bin

Deleted files are moved to the Recycle Bin and remain there until you empty the Recycle
Bin. If you delete a file in error, you can retrieve it from the Recycle Bin:

Double-click the Recycle Bin : icon.

-

The Recycle Bin window will appear, listing all deleted files, their previous locations, and
the dates you deleted them.

Select the file you want to retrieve, click the File menu, and then click Restore.
The file disappears from the Recycle Bin and is moved to its original location.
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2.9 Playing CDs and Movies

> Inserting Discs
> Adjusting Volume

> Adjusting the Picture
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2.9.1 Inserting Discs

Be careful not to press down on the drive tray when opening or closing it. When the
drive is not in use, keep the tray closed.

& Do not move the computer when playing CDs or DVDs.

To insert a disc, do the following:

1. Press the eject button on the front of the drive.

2. Pull the tray out.

3. With the label side up, place the disc in the center of the tray.

4. Snap the disc onto the spindle.

5. Gently push the tray back into the drive.

If your notebook has a CD-RW/DVD or DVD, you can watch movies.

For more information on playing CDs or watching movies, click Help on the CD player
software or DVD player software.

2.9.2 Adjusting Volume

r@‘ If you do not hear anything when playing a CD or DVD, check that the speakers are
not muted.

Start > All Programs > Accessories > Entertainment > Volume Control.

In the Volume Control window, click and drag the bar in the Volume Control column and
slide it up or down to increase or decrease the volume.

Fo || Audio Volume Down
v,

" I Audio Volume Up

2.9.3 Adjusting the Picture

If you receive an error message that the current resolution and color depth are using too
much memory and preventing DVD playback, adjust the display properties:

Start > Control Panel > Pick a category > Appearance and Themes > Pick a task... >
Change the screen resolution.

In the Display Properties window, click and drag the bar in Screen resolution to change
the setting to 1024 x 768 pixels.

Click the pull-down menu under Color quality > Medium (16 bit) > OK.
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3 Caring for Your Notebook

3.1 Caring for Your Notebook

Cleaning Your Notebook and Keyboard
Cleaning the Display
Cleaning the Touch Pad

Cleaning the CD/DVD Drive
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Precautions

Never spray cleaning products directly onto your notebook's case or display. Only
use products designed for cleaning computer displays.
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3.1.1 Cleaning Your Notebook and Keyboard

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and
any external devices, such as a printer.

Remove the battery packs.

Use the brush attachment of your vacuum cleaner, gently remove dust from your
notebook’s openings and keyboard.

Use a slightly moistened soft, lint-free cloth, wipe your notebook and keyboard.
Use only water or a recommended computer cleaner.

3.1.2 Cleaning the Display

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and
any external devices, such as a printer.

Remove batteries.

Use a slightly moistened soft, lint-free cloth, wipe your notebook's display. Use
only water or a recommended computer cleaner.

3.1.3 Cleaning the Touch Pad

1.

Shut your notebook down, turn it off and disconnect from the electrical outlet and
any external devices, such as a printer.

Remove batteries.

Use a slightly moistened soft, lint-free cloth, carefully wipe the Touch Pad, being
careful not to allow any moisture into the gaps. Use only water or a recommended
computer cleaner.

3.1.4 Cleaning the CD/DVD Drive

& Never touch the lens. Use only compressed air to clean the lens.

If you experience problems playing CDs or DVDs, including skipping, clean the unlabelled
side of the disc with a soft, lint-free cloth or using a commercial product.
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3.1.5 Precautions

Do not spill liquids on the keyboard. If liquid is spilt on the keyboard, turn your
notebook off immediately. Leave off overnight to let it completely dry out
before using it again.

Do not turn off your notebook if a drive light indicates a drive is active. Turning
off your notebook while it is reading from or writing to a disk may damage the
disk, the drive, or both.

Keep your notebook and disks away from objects that generate strong magnetic
fields, such as stereo speakers. Information on disks is stored magnetically.
Placing a magnet too close to a disk can erase important files.

Scan all new files for viruses. This precaution is especially important for files
you receive via email, disk, or download from the Internet. You will need a
special program to scan for viruses. For further information, talk to your
computer dealer.
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3.2 Traveling
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Identifying Your Notebook
Packing Your Notebook
Setting a Password

Travel Tips

If Your Notebook Is Lost or Stolen

3-5



3

Caring for Your Notebook

3.2.1 Identifying Your Notebook

Attach a nametag or business card to your notebook, or use a permanent marker or stencil to
write a unique identifying mark (such as your driver's license number) on the case.

Create a file on the Desktop called if found. Place information such as your name, address,
and telephone number in this file.

Contact your credit card company, and ask if it offers coded identification tags.

3.2.2 Packing Your Notebook

Remove any external devices attached to the computer and store them in a safe place.
Remove any cables attached to installed PC Cards, and remove any extended PC Cards.

Fully charge the main battery and any spare batteries you plan to carry with you.
Turn off the computer or put the computer into hibernate mode.
Disconnect the AC adapter.

Remove any extraneous items, such as paper clips, pens, and paper, from the keyboard and
then close the display.

Pack your notebook and accessories in their carry case.
Avoid packing the computer with items such as shaving cream, colognes, perfumes, or food.

Protect the computer, the batteries, and the hard drive from hazards such as extreme
temperatures, dirt, dust, liquids, or overexposure to sunlight.

Pack the computer so that it does not slide around in the trunk of your car or in an overhead
storage compartment.

& When traveling by air, never check in your notebook as baggage.

3.2.3 Setting a Password

To provide extra protection for your data and documents, it is advisable to set a password.

As your notebook is booting (starting up), press F2 to take you to the BIOS Setup Utility.
Use the right arrow key to highlight Security.

Use the down arrow key to select: Set Supervisor Password. Press Enter.

Type your password, press Enter and re-type to confirm. Press Enter. Your changes will be
saved. Press Enter to continue.

Use the right arrow key to select Exit, use the down key to select Exit Saving Changes.
Press Enter and Yes. Your notebook will now boot as normal.
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3.2.4 Travel Tips

e Ifyou are traveling internationally, carry proof of ownership—or of your right to
use the computer if it is company-owned—to speed your passage through
customs. Investigate the customs regulations of the countries you plan to visit
and consider acquiring an international carnet (also known as a merchandise
passport) from your government.

e Ensure that you know which electrical outlets are used in the countries you will
visit, and have appropriate power adapters.

e Check with your credit card company for information about the kinds of
emergency travel assistance it offers to users of portable computers.

e When traveling by air, ensure that you have a charged battery available in case
you are asked to turn on the computer.

e Before you use the computer on an airplane, verify that such usage is permitted.
Some airlines forbid the use of electronic devices during the flight. All airlines
forbid the use of electronic devices during takeoff and landing.

& Never walk your notebook through a metal detector. Send it through an X-ray
machine, or have it manually inspected.

3.2.5 If Your Notebook Is Lost or Stolen

Call a law enforcement agency to report your notebook lost or stolen. Ask that a case
number be assigned and write down the number, along with the name, address, and
telephone number of the law enforcement agency. If possible, obtain the name of the
investigating officer.

If the notebook belongs to a company, notify the security office of the firm.
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3 Caring for Your Notebook

3.1 Caring for Your Notebook

Cleaning Your Notebook and Keyboard
Cleaning the Display
Cleaning the Touch Pad

Cleaning the CD/DVD Drive
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Precautions

Never spray cleaning products directly onto your notebook's case or display. Only
use products designed for cleaning computer displays.
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3.1.1 Cleaning Your Notebook and Keyboard

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and
any external devices, such as a printer.

Remove the battery packs.

Use the brush attachment of your vacuum cleaner, gently remove dust from your
notebook’s openings and keyboard.

Use a slightly moistened soft, lint-free cloth, wipe your notebook and keyboard.
Use only water or a recommended computer cleaner.

3.1.2 Cleaning the Display

1.

Shut your notebook down, turn it off and disconnect it from the electrical outlet and
any external devices, such as a printer.

Remove batteries.

Use a slightly moistened soft, lint-free cloth, wipe your notebook's display. Use
only water or a recommended computer cleaner.

3.1.3 Cleaning the Touch Pad

1.

Shut your notebook down, turn it off and disconnect from the electrical outlet and
any external devices, such as a printer.

Remove batteries.

Use a slightly moistened soft, lint-free cloth, carefully wipe the Touch Pad, being
careful not to allow any moisture into the gaps. Use only water or a recommended
computer cleaner.

3.1.4 Cleaning the CD/DVD Drive

& Never touch the lens. Use only compressed air to clean the lens.

If you experience problems playing CDs or DVDs, including skipping, clean the unlabelled
side of the disc with a soft, lint-free cloth or using a commercial product.
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3.1.5 Precautions

Do not spill liquids on the keyboard. If liquid is spilt on the keyboard, turn your
notebook off immediately. Leave off overnight to let it completely dry out
before using it again.

Do not turn off your notebook if a drive light indicates a drive is active. Turning
off your notebook while it is reading from or writing to a disk may damage the
disk, the drive, or both.

Keep your notebook and disks away from objects that generate strong magnetic
fields, such as stereo speakers. Information on disks is stored magnetically.
Placing a magnet too close to a disk can erase important files.

Scan all new files for viruses. This precaution is especially important for files
you receive via email, disk, or download from the Internet. You will need a
special program to scan for viruses. For further information, talk to your
computer dealer.
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Identifying Your Notebook
Packing Your Notebook
Setting a Password

Travel Tips

If Your Notebook Is Lost or Stolen
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3.2.1 Identifying Your Notebook

Attach a nametag or business card to your notebook, or use a permanent marker or stencil to
write a unique identifying mark (such as your driver's license number) on the case.

Create a file on the Desktop called if found. Place information such as your name, address,
and telephone number in this file.

Contact your credit card company, and ask if it offers coded identification tags.

3.2.2 Packing Your Notebook

Remove any external devices attached to the computer and store them in a safe place.
Remove any cables attached to installed PC Cards, and remove any extended PC Cards.

Fully charge the main battery and any spare batteries you plan to carry with you.
Turn off the computer or put the computer into hibernate mode.
Disconnect the AC adapter.

Remove any extraneous items, such as paper clips, pens, and paper, from the keyboard and
then close the display.

Pack your notebook and accessories in their carry case.
Avoid packing the computer with items such as shaving cream, colognes, perfumes, or food.

Protect the computer, the batteries, and the hard drive from hazards such as extreme
temperatures, dirt, dust, liquids, or overexposure to sunlight.

Pack the computer so that it does not slide around in the trunk of your car or in an overhead
storage compartment.

& When traveling by air, never check in your notebook as baggage.

3.2.3 Setting a Password

To provide extra protection for your data and documents, it is advisable to set a password.

As your notebook is booting (starting up), press F2 to take you to the BIOS Setup Utility.
Use the right arrow key to highlight Security.

Use the down arrow key to select: Set Supervisor Password. Press Enter.

Type your password, press Enter and re-type to confirm. Press Enter. Your changes will be
saved. Press Enter to continue.

Use the right arrow key to select Exit, use the down key to select Exit Saving Changes.
Press Enter and Yes. Your notebook will now boot as normal.
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3.2.4 Travel Tips

e Ifyou are traveling internationally, carry proof of ownership—or of your right to
use the computer if it is company-owned—to speed your passage through
customs. Investigate the customs regulations of the countries you plan to visit
and consider acquiring an international carnet (also known as a merchandise
passport) from your government.

e Ensure that you know which electrical outlets are used in the countries you will
visit, and have appropriate power adapters.

e Check with your credit card company for information about the kinds of
emergency travel assistance it offers to users of portable computers.

e When traveling by air, ensure that you have a charged battery available in case
you are asked to turn on the computer.

e Before you use the computer on an airplane, verify that such usage is permitted.
Some airlines forbid the use of electronic devices during the flight. All airlines
forbid the use of electronic devices during takeoff and landing.

& Never walk your notebook through a metal detector. Send it through an X-ray
machine, or have it manually inspected.

3.2.5 If Your Notebook Is Lost or Stolen

Call a law enforcement agency to report your notebook lost or stolen. Ask that a case
number be assigned and write down the number, along with the name, address, and
telephone number of the law enforcement agency. If possible, obtain the name of the
investigating officer.

If the notebook belongs to a company, notify the security office of the firm.
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4.1 PC Cards and Express Cards

YV VvV VvV YV VY V¥V

PC Card Types
Extended PC Cards
Installing a PC Card
Removing a PC Card
Express Card Types

Installing and Removing Express Cards
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4.1.1 PC Card Types

The PC Card slot supports one Type Il card. It also supports CardBus technology and
extended PC Cards. "Type" refers to the card's thickness, not what it does.

( A PC Card is not a bootable device.
Sl

41.2 Extended PC Cards

An extended PC Card is longer than a standard PC Card. When using extended PC Cards,
follow these precautions:

= Protect the exposed end of an installed card. If the end of the card is struck, the system
board may be damaged.

= Always remove an extended PC Card before packing your notebook in its carry case.

4.1.3 Installing PC Cards

PC Cards may be 'hot-swapped', which means you can install a card while your notebook is
running. The card will be detected automatically.

Usually PC Cards have a mark or symbol to show which end to insert into the slot. Cards are
keyed to prevent incorrect insertion. Check the documents that came with your card if the
orientation is unclear.

1. Hold the card with its orientation symbol pointing into the slot and the topside of
the card facing up. The push-button latch may need to be pushed in before inserting
the card.

2. Slide the card into the slot until it clicks into the connector.

3. If you encounter too much resistance, do not force the card. Check the card

orientation and try again.

Your notebook will recognize most PC Cards and automatically load the appropriate device
driver. If the configuration program tells you to load the manufacturer's drivers, use the
floppy disk or CD that came with the PC Card.
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4.1.4 Removing PC Cards

& Before removing a PC Card, stop it running from the configuration utility on the
taskbar. Failure to do so could result in data loss. Never try to remove a PC Card
by pulling on its cable, if one is attached.

1. Press the release latch.
2. Press the latch again to eject the card.
3. Remove the card.

4.1.5 Express Card Types

The Express Card slot supports one 54mm type PCI-Express card. It supports both USB 2.0
and PCI Express technology, which improves bus speed in data transfer and requires less
power than PC Cards.

4.1.6 Installing and Removing Express Cards

Express Cards, with hot-plug feature, allow you to install and remove cards when your
notebook is running. The card will be detected automatically when installed.

Usually Express Cards have a mark or symbol to show which end to insert into the slot.
Insert the card according to the orientation symbol, and slide the card into the slot.

To remove it, pull it out gently.
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4.2 Adding and Removing SD/MMC/MS Cards

Before removing a SD/MMC/MS card, stop it running from the configuration utility
on the taskbar. Failure to do so could result in data loss.

Insert the SD/MMC/MS card into the Card reader slot.

To remove the SD/MMC/MS Card, push it in gently and it ejects automatically.
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4.3 Memory Modules

You can add more memory modules to your computer in order to give it improved
performance.

|
.

€
3

b

To remove a memory module:

1. Remove the two screws securing the memory module cover.

2. Lift off the memory module cover.

3. Pop out the two silver latches holding the memory module into place. The module
pops up.

4. Grasp the outer edges of the memory module with thumb and forefinger, and then

gently remove it.

To install a memory module:

1. Remove the two screws securing the memory module cover.
2. Lift off the memory module cover.
3. There are two memory module ports here. The first one is already occupied by your

computer’s current memory module. Place the new memory module in the second
slot, matching up the notch along its connector rim with the tooth in the connection
slot.

4. When the module has been securely seated, press down gently on it until it snaps
into place.

& Depending on how much additional memory you require, you may need to replace
the original memory module.
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5.1 Power Management

> Power Management Modes
> Power Options Properties

> SpeedStep
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Your computer comes with built-in power management. You can configure it, through the
Power Options program in the Control Panel, to sleep, hibernate, and wake according to
specific pre-defined situations.

When leaving your notebook unattended for long periods, place it in standby or hibernate
mode. You can exit either power management mode by pressing the power button.

’QI See 5.2 Battery for more information on getting the best performance from battery
packs.

’Q‘ Use your notebook connected to an electrical outlet as often as possible, as battery
life expectancy is affected by the number of times it is charged.

5.1.1 Power Management Modes

5.1.1.1 Standby Mode

This mode conserves power by switching off the hard drive and display after a preset period
of inactivity (a time-out). When standby mode is exited, your notebook will return to the
same operating state it was before entering standby.

If your notebook loses power from both the electrical outlet and the battery while in
standby mode, data may be lost.

To enter standby mode in Windows XP: Start > Turn off computer > Stand By.
Or set your notebook to go to Standby mode:

e When you close the lid of your notebook
e When you press the power button

e When you press the sleep hot key

The settings can be accessed via the Advanced tab in Power Options Properties (Start >
Control Panel > Pick a category > Performance and Maintenance > Power Options).

To exit standby mode, press the power button. You can not exit standby mode by pressing a
key or touching the Touch Pad.

5-2



5 The Power System

5.1.1.2 Hibernate Mode

In Hibernate mode, power is conserved by system data being copied to the hard drive, and
your notebook is completely shut down. When Hibernate mode is exited, your notebook
will return to the same operating state it was in before entering Hibernate mode.

Hibernate mode can be enabled/disabled in the Power Options Properties window.

If enabled, your notebook will go into Hibernate mode if the battery charge level becomes
critically low.

Depending on how you set the Power Management Options on the Advanced tab in the
Power Options Properties window, use one of the following methods to enter hibernate
mode:

e When you close the lid of your notebook
e When you press the power button
e When you press the sleep hot key

e Start > Turn Off Computer > Hibernate (if the Hibernate option does not
show, press Shift, and the Standby option will switch to Hibernate).

If the Hibernate option is not available for these methods, Hibernate mode has not been
enabled. Check the Enable hibernation box on the Hibernate tab of the Power Options
Properties window and click Apply to enable Hibernation.

'Q] If your PC Cards do not operate correctly after exiting Hibernate mode, remove
and reinsert the card or restart your notebook.

To exit Hibernate mode, press the power button. You cannot exit Hibernate mode by
pressing a key or touching the Touch Pad.
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5.1.2 Power Options Properties

To access the Windows Power Options Properties window:

Start > Control Panel > Pick a category > Performance and Maintenance > Power
Options

5.1.2.1 Power Schemes Tab

The Power schemes pull-down menu in the Power Options Properties displays the selected
preset power scheme.

@ To maximize battery power, use the Portable/Laptop power scheme.

In Windows XP the processor's performance level depends on the power scheme you select.
You do not need to make any further adjustments to set the performance level. Each preset
power scheme has different time-out settings for entering standby mode, hibernate mode,
turning off the display, and turning off the hard drive. For more information on power
management options, see the Help and Support Center.

5.1.2.2 Alarms Tab

'QI Enable audible alarms by clicking each Alarm Action button and selecting Sound
alarm.

The Low battery alarm and Critical battery alarm settings alert you when the battery charge
falls below a certain percentage.

When you receive your notebook, the Low battery alarm and Critical battery alarm check
boxes are selected. See 5.2 Battery for more information on low-battery warnings.

5.1.2.3 Power Meter Tab
Displays the current power source, battery status, and charge amount.
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5.1.2.4 Advanced Tab
With the Advanced tab you can:

= Set power icon and standby mode password options.

= Depending on your operating system, program the following functions by clicking an
option from the corresponding pull-down menu, and then clicking OK.

> Set the computer to Stand by/Hibernate/Do nothing when you close the laptop lid

> Set the computer to Ask me what to do/Stand by/Hibernate/Shut down/Do
nothing when you press the power button.

> Set the computer to Ask me what to do/Stand by/Hibernate/Shut down/Do
nothing when you press the sleep hot key.

5.1.2.5 Hibernate Tab

The Hibernate tab lets you enable Hibernate mode by clicking the Enable hibernation
check box.
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5.1.3 SpeedStep

Your notebook is equipped with SpeedStep technology to better manage power
consumption. It changes the processor speed to find the best balance between your
computing performance and power consumption needs. Higher speeds enjoy better
performance, while slower speeds conserve more power.

In Windows XP, the processor's performance level depends on the Power Scheme you select
(see 5.1.2 Power Options Properties). You do not need to make any further adjustments to
set the performance level. Each preset power scheme has different time-out settings for
entering standby mode, hibernate mode, turning off the display, and turning off the hard
drive.

For example, the Portable/Laptop mode automatically changes SpeedStep modes
depending on if you are running the computer on AC power or batteries in order to prolong
battery usage while still providing optimal performance.

You can also individually alter and save each of these settings and schemes if desired.

Power Options Properties

Power Schemes | Alams || Power Meter || Advanced || Hibemate
& Select the power scheme with the most appropriate settings for
\ this computer. Mote that changing the settings below will modify
the selected scheme.
Power schemes
HomeOffice Desk W
Home/ffice Desk
: Portable/Laptop
Presentation
Alwavs On
Minimal Power Management
[z Battery
VWhen computer is: Flugged in i IR
batteries
Tum off manitar: |_-'l:|'-ter 20 mins W | |.-"~'f'ter 5 mins W |
Tum off hard disks: | MNewver v | |.-"-'f'ter 10 mins w |
System standby: | MNewer w | | Mewver w |
System hibemates: | Mever w | |.-'l'-f'ter 15 ming w |
| ok || cance || ool |

Windows XP automatically chooses the SpeedStep mode to find the most appropriate speed
for your processor according to the Power Scheme you choose and your current system
demands.
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5.2 Battery

vV ¥V Vv V ¥V ¥V V VY VY V

Battery Performance

Checking the Battery Charge
Power Meter

Low-Battery Warning

Charging the Battery

Removing a Battery

Installing a Battery

Storing a Battery

Working With Extra Battery Packs

Maximizing Battery Life
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5.2.1 Battery Performance

The performance of the battery can vary, depending on operating conditions. Your battery
may last less time if you are running power-intensive programs, playing CDs or DVDs,
using PC Cards or have high display-brightness settings.

The Power Management Options can be set to alert you when the battery charge is low.

Ensure any battery you use is compatible. Failure to do so may risk fire or
explosion. For more details on purchasing compatible batteries, contact your
notebook retailer.

Batteries should never be disposed of with household waste. Contact your local
waste disposal or environmental agency for advice on disposing of used lithium-ion
batteries.

& Only use the 908C3500F, ID6 or 9ONITLILD4SUX battery pack with this computer.

5.2.2 Checking the Battery Charge

Battery Status || Indicator behavior

Charging Solid amber

Fully Charged || Solid green

Discharging Off

Critical Low Blinks amber > approximately 3 minutes left; system beeps

5.2.3 Power Meter

The power meter ' indicates the remaining battery charge. When your notebook is
running on battery power, you can check the remaining battery charge, double click

the ' icon on the taskbar. For more details, including how to make the icon appear on the
taskbar if it is not already, see 5.1 Power Management.
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5.2.4 Low-Battery Warning

After a low-battery warning, save your work immediately, then connect your
notebook to an electrical outlet. Hibernate mode will begin automatically if the
battery runs completely out of power.

You will hear the low-battery warning when the battery charge is approximately 90 percent
depleted. Your notebook will beep once, indicating approximately 10 to 15 minutes of
battery operating time remain. If you do not connect your notebook to alternative power
source during that time, there will be a periodic beep. If the battery charge reaches a
critically low level, your notebook will automatically enter Stand by/Hibernate/Shut
down mode, which is set in Alarms Tab. For more information, see 5.1 Power
Management.

5.2.5 Charging the Battery

'Q‘ When connected to an electrical outlet, a completely discharged battery needs to be
charged in 4 to 12 hours (depending on whether your notebook is on or off and what
programs, if any, are running). You can leave the battery in your notebook as long
as you like. The battery’s internal circuitry prevents the battery from overcharging.

Before using the battery for the first time it must be charged. Connect the computer to an
electrical outlet and allow the battery to fully charge, indicated by the battery indicator light
on the front panel of the notebook.

'Q‘ Once a battery pack is fully charged for the first time, use your notebook on battery
power until the battery discharges completely. This will extend battery life, and
helps ensure accurate monitoring of battery capacity.

If necessary, the battery will be charged whenever your notebook is connected to an
electrical outlet.

The battery will not be charged if it or your notebook is too hot, either from use or being in
a hot environment. If this occurs, the battery indicator will light amber. Disconnect your
notebook from any electrical outlet, and allow it and the battery to cool to room temperature.
You can then reconnect your notebook to the electrical outlet and charge the battery. The
battery indicator will also light amber if the battery is bad and needs replacing.

5.2.6 Removing the Battery

Before removing the battery, ensure your notebook is turned off.

1. Move the battery lock switch to the right (Unlock position).
2. Slide and hold the battery release latch.

3. Remove the battery.

5-9



5 The Power System

5.2.7 Installing a Battery

1. Slide the battery into the bay.
2. Press it into place gently but firmly until the latch locks it into place.

5.2.8 Storing a Battery

If storing your notebook for an extended period of time, remove the battery. Fully charge the
battery before using your notebook again.

5.2.9 Working With Extra Battery Packs

If you spend a lot of time traveling, working without connecting your notebook to an
electrical outlet, it may be a good idea to carry additional battery packs so you can quickly
replace a discharged battery and continue working.

5.2.10 Maximizing Battery Life

A battery can be recharged many times, but over time it will lose its ability to hold a charge.
To maximize battery life:

e If you will not be using your notebook for a long period, remove the battery.
e If you have a spare battery pack, alternate the batteries.
e Ensure your notebook is off when replacing the battery.

e Store spare battery packs in a cool, dry place, and out of direct sunlight.
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6 The BIOS Setup Program

6.1 Introduction

The BIOS (Basic Input and Output System) Setup program is a menu driven utility that
enables you to make changes to the system configuration and tailor the operation of your
notebook to your individual work needs. A ROM-based configuration utility displays the
system's configuration status and provides you with a tool to set system parameters. These
parameters are stored in nonvolatile battery backed-up CMOS RAM, which saves this
information even when the power is turned off. When the computer is turned back on, the
system is configured with the values found in CMOS. Using easy-to-use menus, you can
configure such items as:

= Hard drives, diskette drives and peripherals
= Video display options
= Password protection from unauthorized use

=  Boot devices

The settings made in the Setup program intimately affect how the notebook performs. It is
important, therefore, first to try to understand all the available options, and second, to make
settings appropriate for the way you use the notebook. This chapter guides you through the
Setup program by providing clear explanations for all Setup options.

A standard configuration has already been set in the Setup program by the factory
technicians, so you will very likely have little to worry about for now. However, eventually
you may want to customize your system to suit your own performance needs. It is
recommended that you read this chapter and become familiar with the adjustments that can
be made in the BIOS.

The next section explains how to move around in the Setup program, as well as how to
specify and save your new settings. A brief discussion of the optional settings among the
different submenus follows.
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6.2 Navigating through the B10OS Setup Program

> Accessing the BIOS Setup program
> Launching submenus

> Saving Changes and Exiting the Setup
Program

The Setup program has been designed to make it as easy to use as possible. It is a menu
driven program, which means you can scroll through the various directories and make your
selections among the various predetermined choices. If you accidentally configure a setting
and do not know which one to switch back to, use the BIOS hot keys to return to the
previous value. The hot keys are discussed in more detail later in this chapter.

When turning on the notebook for the first time you may get a message prompting you to
run the BIOS Setup program. A warning message may appear on the screen if the hardware
configuration is changed or the POST fails. This message will inform you of any errors or
invalid settings and prompt you to run the Setup program to correct the problem.

Even if you are not prompted by a message instructing you to use the Setup program, at
some time in the future you may want to change the configuration of your computer. For
example, you may want to make changes to the display option settings or enable the
notebook's password function for security purposes. It will then be necessary to reconfigure
your system using the Setup program so that the computer can recognize these changes.

The list below gives a few examples of reasons why you may want or need to run the BIOS
Setup program.

* You have set up the computer for the first time and you got a message stating that
you should run the BIOS Setup program.

* You want to redefine the communication ports to prevent any conflicts.

* You want to change the password or make other changes to the security setup.

@J The few examples listed above are by no means a complete list.
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6.2.1 Accessing the BIOS Setup program

To access the BIOS Setup program, press the F2 key as soon as the computer starts up and
you see the Phoenix BIOS screen.

PhoenixBIOS Setup Utility
Main Advanced Security Boot Exit
Item Specific Help
System Time: [19:34:35]
System Date: [01/01/2005]
Hard Disk: Hard Disk model name , capacity
Quiet Boot: [Enabled]
Power on display: [Auto-Selected}
LCD Display stretch [Enabled]
System Memory: 640 KB
Extended Memory: 1022 MB
BIOS Ver. XXXXX
Language [English (US)]
F1 Help ™ Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit «— Select Menu Enter Select » Sub-Menu F10 Save and Exit

The Menu Bar

The top of the Setup screen has a menu bar with the following selections:

Main
Advanced
Security
Boot

Exit

Allows the user to configure standard IBM PC AT system parameters.
Allows the user to configure advanced system settings.
Allows the user to configure security system settings.

Allows the user to specify the order in which the notebook is to check
for a device to boot the system.

Allows the user to exit the Setup program.
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To move between menu bar items, use the [ €] and [ ] arrow keys until the desired item is
highlighted. For example, if you want to move from the Main menu to the Advanced menu,
press the right arrow key [P ] once.

Item Specific Help

At the right of the Setup screen, you will notice an item specific help bar. For each item that
you select on the menu, the bar informs of its specific function as well as the hot keys related
specifically to that item and/or submenu.

6.2.2 Launching submenus

A submenu contains additional options for a field parameter. To call up a submenu, simply
move the highlight to the desired field and press the [Enter] key. The submenu opens.

If you are a first time user or are not familiar with BIOS Setup programs, it is highly
recommended that you take a few minutes to familiarize yourself with each of the submenus
and their corresponding functions. If you accidentally make unwanted changes to the
current configuration, go to the Exit menu and select Discard Changes.

6.2.3 Saving Changes and Exiting the Setup Program

Refer to the Exit Menu section of this chapter for detailed information on saving changes
and exiting the Setup program.
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6.3 The Main Menu

When the Setup program is accessed, the Information screen appears. It displays the

following pieces of information

regarding your current system:

PhoenixBIOS Setup Utility
Main Advanced Security Boot Exit
Item Specific Help
System Time: [19:34:35]
System Date: [01/01/2005]
Hard Disk: Hard Disk model name , capacity
Quiet Boot: [Enabled]
Power on display: [Auto-Selected}
LCD Display stretch [Enabled]
System Memory: 640 KB
Extended Memory: 1022 MB
BIOS Ver. XXXXX
Language [English (US)]
F1 Help ™ Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit «— Select Menu Enter Select » Sub-Menu F10 Save and Exit

System Time and System Date

The hour is displayed with 24-hour format. The values set in these two fields
take effect immediately.

Hard Disk

The hard disk information is displayed with the manufacturer and model name.

Quiet Boot

Enabled: Customer logo is displayed; Summary screen is disabled.

Disabled: Customer

Power on Display

logo is not displayed; Summary screen is enabled.

This option is auto-selected. Displays on an external monitor if connected,
otherwise it will be displayed on the laptop LCD.
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LCD Display Stretch
Disabled: Disables vertical LCD stretch; enables horizontal LCD stretch.
Enabled: Enables vertical LCD stretch; enables horizontal LCD stretch.
System Memory

This field reports the memory size of system base memory. The size is fixed to
640KB.

Extended Memory

This field reports the memory size of the extended memory with an integer in
the system, but 32Bit SMI will occupy 1 MB and UMA frame buffer (Integrated
VGA uses only).

Extended Memory size = Total memory size - 1 MB — 1 MB — UMA frame
buffer

BIOS Ver
This field displays current version of the BIOS.
Language

This field allows the user to change the languages among English, Japanese,
and French.
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6.4 The Advanced Menu

Selecting Advanced on the menu bar displays the Advanced Menu. Each field on this menu
is covered below.

PhoenixBIOS Setup Utility
Main Advanced Security Boot Exit
Item Specific Help
Legacy USB Support [Enabled]
Execute-Disable Bit Capability [Disabled]
Dynamic CPU Frequency Mode [Dynamic]
Built-in LAN: (Option) [Enabled]
DVMT 3.0 Mode: (Option) [DVMT]
Pre-Allocated Memory Size: (Option) [SMB]
Total Graphics Memory: (Option) [128MB]
DVMT Graphics Memory: (Option) 120MB
F1 Help T Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit <— Select Menu Enter Select * Sub-Menu F10 Save and Exit
Legacy USB Support

Disabled: Disables the legacy USB support.
Enabled: Enables the legacy USB support.
Execute-Disable Bit Capability

Disabled: Forces the Execute-Disable Bit Capability extended feature bit to
always return to 0.

Enabled: Enabled.
Dynamic CPU Frequency Mode
Always Low: The CPU always runs at low power consumption and low speed.

Dynamic: When the computer is in use, CPU operation is automatically
switchable when necessary.

Build-in LAN (Option)
Disabled: Disables built-in LAN..
Enabled: Enables built-in LAN.
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DVMT 3.0 Mode (Option)

Select the configuration of DVMT 3.0 Graphics
Memory that Driver will allocate for use by the
Internal Graphics Device

Fixed:

DVMT:

Combo:

Pre-Allocated Memory Size (Option)

Select the amount of Pre- Allocated Graphics
Memory for use by the Internal Graphics Device
1MB:

8MB:

Total Graphics Memory (Option)

Select the amount of total graphics memory
Pre-Allocated + Fixed + DVMT for use by the
Internal Graphics Device.

64MB:

128MB:

MaxDVMT:

DVMT Graphics Memory (Option)

DVMT Graphics Memory Size
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6.5 The Security Menu

The notebook's advanced security system allows you to set a password to prevent
unauthorized access to system resources, data, and the BIOS Setup program. This section
covers each Security parameter. Selecting Security from the menu bar displays the Security
menu.

A Note about Passwords

The BIOS Setup program allows you to specify passwords in the Security menu. The
passwords control access to the BIOS and certain Security menu options during system
startup.

Passwords are not case sensitive. A password can be entered using either upper or lower
case letters; it makes no difference. When you choose your password, it should be
composed of characters A-Z, 0-9 and eight characters in length.

NOTE: The administrator password must be set before the user password can be set.

Set User Password... / Set Admin Password...
PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit
Item Specific Help

User Password Is: Clear
Supervisor Password Is: Clear

Set User Password: [Enter]

Set Supervisor Password: [Enter]
Password on boot: [Enabled]
Built-in HDD Status Clear
Built-in HDD Password Select [User Only]
Set HDD User Password [Enter]

» Trusted Platform Module Setting. (Option)

F1 Help M select item F5/F6 change values F9 Setup defaults

Esc Exit <—> select menu Enter Select » Sub-Menu F10 Save and Exit

These fields allow you to set the System Password. The System Password allows full access
to the BIOS Setup menus. To set the Supervisor password, highlight this field and press
[Enter].
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Type the password and press the [Enter] key. You can type up to ten alphanumeric
characters. Symbols are ignored.

To confirm the password, type the password again and press the [Enter] key.

User Password Is / Supervisor Password Is
These two fields shows that User /Supervisor Passwords are set or not.
Set System Password is set.

Clear  System Password is not set.

Set Supervisor Password / Set User Password
Enter this field always shows the message.

While this field is highlighted, press “Enter”. The following message is shown:

Set Supervisor Password
Enter New Password [ ]

Confirm New Password [ ]

If there is an old password then setup will prompt with the following window instead and a
current password will be required to be entered at first:

Set Supervisor Password
Enter Current Password [ ]
Enter New Password [ ]
Confirm New Password [ ]

User can type password in field of “Enter New Password”, and re-enter password in field of
“Confirm New Password “ for verification.

If verification OK:

Setup Notice
Changes have been saved.

[Continue]

The supervisor password is set complete after user press “Enter”.

If verification fails:

Setup Warning
Passwords do not match.
Re-enter Password.

[Continue]

If password on boot is required, the password must be set otherwise it cannot be enabled.
The formats of the password are as follows:
Length:  No more than 8 characters.

Characters: Alphanumeric keys only. The shift status, Ctrl, Shift, Alt, and Capital, are
ignored.
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Built-in HDD Status
Set HDD Password is set.
Clear  HDD Password is not set.
Password on boot
Enabled: Enables Password entry on boot.
Disabled: Disabled Password entry on boot.
Built-in HDD Password Select
User Only For normal user entering HDD password.

User+Master Master password must be set first before user password can be
configured.

Set HDD User Password / Set HDD Master Password
Enter this field always shows the message.

While this field is highlighted, press “Enter”. The following message is shown:

Set HDD Master Password
Enter New Password [ ]
Confirm New Password [ ]

If there is an old password then setup will prompt with the following window instead and a
current password will be required to be entered at first:

Set HDD Master Password
Enter Current Password [ ]
Enter New Password [ ]
Confirm New Password [ ]

User can type password in field of “Enter New Password”, and re-enter password in field of
“Confirm New Password “ for verification.

If verification OK:

Setup Notice
Changes have been saved.

[Continue]

The HDD password is set complete after user press “Enter”.

If verification fails:

Setup Warning
Passwords do not match.
Re-enter Password.

[Continue]

If password on boot is required, the password must be set otherwise it cannot be enabled.
The formats of the password are as follows:

Length:  No more than 8 characters.
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Characters: Alphanumeric keys only. The shift status, Ctrl, Shift, Alt, and Capital, are
ignored.

Trusted Platform Module Setting. (Option)

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit
Trusted Platform Module Setting. (Option) Item Specific Help
Security Chip State Enabled

Deactivated

Trusted Platform Support [Disabled]

F1 Help ™ Select Item F5/F6 Change Values F9  Setup Defaults

Esc Exit <—> Select Menu Enter Select » Sub-Menu  F10 Save and Exit

Security Chip State

Enabled & Activate: Enable security chip encrypted data and user from taking

ownership.

Disable & Deactivate: Disable security chip prevents encrypted data from being

used and Deactivated security chip prevents a user from taking ownership.

Trusted Platform Support

Disabled: Disables Trusted Platform Module support.
Enabled: Enables Trusted Platform Module support.

Clear Security Chip

Clear Security Chip to default state and release ownership.

Change Security Chip State

No Change

Enable & Activate: Enable security chip encrypted data and user from taking

ownership.

Disables & Deactivate Disable security chip prevents encrypted data from
being used and Deactivated security chip prevents a user from taking
ownership.
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6.6 Boot Menu

This menu allows the user to decide the order of boot devices to load the operating system.
Bootable devices include the diskette drive in module bay, the onboard hard disk drive and
the CD-ROM in module bay.

PhoenixBIOS Setup Utility

Main Advanced Security Boot Exit
Item Specific Help

HDD Hard Disk Model name
CD/DVD CD/DVD Drive Model name
FDD
LAN
F1 Help ™ Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit <—> Select Menu Enter Select » Sub-Menu  F10 Save and Exit
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6.7 Exit Menu

PhoenixBIOS Setup Utility
Main Advanced Security Boot Exit
Item Specific Help
Exit Saving Changes
Exit Discarding Changes
Load Setup Defaults
Discard Changes
Save Changes
F1 Help ™ Select Item F5/F6 Change Values F9  Setup Defaults
Esc Exit <—> Select Menu Enter Execute Command F10 Save and Exit

Exit Saving Changes

Allows the user to save changes to CMOS and reboot system. The following message is
prompted when user press “Enter” on the item.

Setup Confirmation
Save configuration changes and exit now?
[Yes] [No]

Yes: Exit SETUP and reboot

No: Go back to previous screen

Exit Discarding Changes

Setup Warning
Configuration has not been saved!
Save before exiting?

[Yes] [No]
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Load Setup Defaults

Allows the user loads default value in CMOS Setup. The following message is prompted
when user press “Enter” on this item:

Setup Confirmation
Load default confirmation now?
[Yes] [No]

Select Yes to confirm or NoO to abort. You will then return to the setup screen.

Discard Changes

Allows the user loads previous value in CMOS Setup. The following message is prompted
when press “Enter” on this item:

Setup Confirmation
Load previous confirmation now?
[Yes] [No]

Select Yes to confirm or No to abort. You will then return to the setup screen.

Save Changes

Allows the user to save changes and not exit Setup. The following message is prompted
when press “Enter” on this item:

Setup Confirmation
Save configuration changes now?
[Yes] [No]

Select Yes to confirm or No to abort. You will then return to the setup screen.
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